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Aims and Learning Objectives 

The aim of this course is to explore the procedures of image capture using a scanner 
and to optimise the resulting digital images using Serif PhotoPlus (or similar image 
editing package). 

On completion of the course, you will be able to: 

 understand colour rendition issues; 

 understand the digitisation process; 

 set scanning parameters adequately for the intended output; 

 capture images using a scanner; 

 crop images; 

 correct perspective problems; 

 adjust the tone and colours of images; 

 sharpen images; 

 scale images; 

 use four different graphic file formats for the right purpose. 
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Introduction 

There is little doubt that the use of digital images in learning, teaching and research 
projects is growing. Typical uses include: supporting lectures and other presentations; 
creating web-based instruction and creating digital image archives. Another aspect of 
digital images is that they can be delivered on a variety of supports: PowerPoint, web, 
image database, CD-ROM and print. It is therefore important to be familiar with image 
digitisation processes in order to obtain images that are ‘fit for purpose’. 

Scanners provides a means for converting analogue images to digital, allowing them to 
be manipulated and enhanced on a computer using a graphics package such as Adobe 
Photoshop or Serif PhotoPlus. 

This course shows you how to make better use of your scanner and apply image 
enhancement techniques using Serif PhotoPlus, an image editor for which the 
University has a site licence. 

Prerequisites 

This course assumes that you are familiar with the use of a computer keyboard and 
mouse, and with the Windows environment. 
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Task 1 Scanning an image 

Objectives To obtain a scan from a traditional film image. 

Comments It is important to set the scanning parameters adequately for the intended image 
output. For example if you want to make an A4 print, you will need to scan the 
original at a setting that provides enough information for a good print at that size. 
Conversely if you scan an image for a website less information will be required. 

 

Preparing to scan 

1.1 Prepare the scanner: 

 Connect the USB cable from the scanner to a free USB slot on the front panel of 
your computer. 

Note    The Canon CanoScan Lide 200 gets its power from the computer via the supplied 
USB cable. 

1.2 Prepare the original: 

 Check the condition of the photograph handed out to you, handle it with care, by its 
sides (avoid touching the surface with your fingers) and check that it is clean – 
gently blow off any obvious dust or hair-like particles if necessary. 

Note    This is the first step towards a quality scan. The more you keep the original image in 
good condition and clean, the better the digital image and the less retouching it will 
need. 

1.3 Place the image in the scanner: 

 Lift the scanner lid and place the photograph facing down on the glass, at least 1 cm 
away from the edges and upside down. 

 Close the lid. 

Starting the scanning process 

1.4 Open PhotoPlus X5 and the scanning software: 

 Press the Start button (bottom left of the screen) select All Programs / Serif 
PhotoPlus / PhotoPlus X5. 

 In the Startup Wizard, in the Create column, select Import From Twain, then 
choose CanoScan LiDE 200 14.0 (32-32) and click Select. 

Note    Alternatively, if you can’t see the Wizard Startup, open the File menu and choose 
Import / Acquire. 

You should now see the ScanGear scanner driver, showing the scanner ‘bed’ 
(where you can preview your scan) on the left and the settings options on the right 
(Figure 1). 

1.5 Preview your scan: 

The scanning software that comes with your scanner usually provides a number of 
adjustable settings. By default ScanGear opens in Basic Mode which offers limited 
features. However, in order to obtain better results it is recommended to switch to 
Advanced Mode. 

 In the settings pane on the right, select the Advanced Mode tab and click OK when 
prompted. 

 Next click on the blue Preview button at the bottom of the settings pane. 

2 
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Figure 1 – ScanGear scan preview and Advanced Mode settings options 

Scanner software like ScanGear usually offers settings (Figure 1) relating to: 

 the type of original you are scanning (Input Settings) – e.g. photograph, plain 
text or printed materials from magazines or newspapers, 

 the type of output you want (Output Settings) – e.g. high quality print, website or 
PowerPoint presentation, publication, 

 image correction options (Image Settings) such as brightness optimisation (Auto 
Tone), sharpening (Unsharp Mask), descreening (used for scanning photos from 
books and magazines), etc, 

 colour adjustment options such as saturation/colour balance, brightness/contrast 
levels and curves adjustments. 

Only the first two concern us at this stage, image correction and colour adjustment 
settings will be set to OFF – except for Unsharp Mask that will be set to ON – or not 
used, because they are better corrected in a dedicated image editing package like 
PhotoPlus. 

1.6 Set the Input Settings options: 

This is where you set the type of artwork (e.g. a colour photograph, a black and 
white photograph, a drawing, a newspaper page, etc) you are scanning. Depending 
on the type there are three main colour modes to be aware of: 

Color : this mode is suitable for scanning colour documents such as photographs. It 
captures 24-bit of data per pixel (i.e. 256 levels (8-bit) each of R(ed), G(reen), and 
B(lue)) to reproduce the full spectrum of 16.7 million colors. 24/8 bit output is the 
standard mode for scanning colour photographs and is good enough for most uses. 
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However if you require extra quality (e.g. for very high quality print), you may want to 
change this to 48-bit (i.e. 16 bit per channel). Click on the Preferences button at the 
bottom, then select the Scan tab and check the Enable 48/16 bit Output option. 

Grayscale : this mode is suitable for scanning black and white photographs, or to 
create black and white images. It captures 8-bit bits of data per pixel (i.e. 256 
shades of gray, including black and white at the extremes). 
If scanning a black and white photograph original, you may get better results setting 
the output type to Colors. This gives you three times more information to work with 
than Grayscale. While this introduces colour into the scan, you can convert it to 
black and white afterwards or desaturate in PhotoPlus. 

Black and White : this mode is suitable for document containing a maximum of two 
colours (usually black and white) without any tonal variations in between. A typical 
example are line art images. 

 Leave the Select Source and Paper Size options to their default settings (i.e. 
Platen and Full Platen respectively) and make sure Color Mode is set to Color. 

1.7 Set the Output Settings options: 

Output Resolution and Output Size are complementary settings which are 
normally dictated by the use to which the resulting scanned image will be put. 

Output Resolution is particularly relevant to print output: it determines the number 
of pixels in a specific area and is usually expressed in pixels per inch (ppi) or dots 
per inch (dpi). For example, a resolution of 300 ppi is usually recommended for a 
high quality print on an inkjet printer. 

Output Size allows you to control size (expressed either in pixels, inches or 
millimetres) of the scanned image. 

If the scanned image is destined to be viewed on a computer screen (e.g. on the 
web on in a PowerPoint presentation), then the pixel dimension is all you need to 
know, the Output Resolution is irrelevant and is best set to 100. 

However, for print output you need to care both for the resolution and size because 
together they help determine the real life dimensions of the image expressed in 
inches or millimetres. For example, if you wanted to print your scanned image at a 
size of 297 x 210 mm (A4 size) at a resolution of 300 ppi (the recommended 
resolution for obtaining a quality print on an inkjet printer), you would need to make 
sure the scanned image pixel size is 3507 x 2480 pixels. 

See Appendix B for further information on resolution and image size for printing. 

 Experiment with different Output Resolution and Output Size settings and try to 
understand what it means (note the changes to the Data Size field). You may also 
want to change the size unit to pixels in the Input Settings options. 

For this task, we will assume that you want to use the present image in a 
PowerPoint presentation, so: 

 Set the Output Resolution to 100, then set the Output Size to Flexible and type 
400 in the % box below (Figure 2). 

 
Figure 2 - Output settings for Egypt image scan 
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The Output Size width and height should be something like 1600 pixels in width x 
2400 pixels in height (or thereabouts). 

Note    If in doubt as to the pixel dimension and/or resolution that you need, aim to get a 
high quality scan – as a rule of thumb, 3500 x 2500 pixels will allow you to 
comfortably print up to A4 on an inkjet printer. From this master version you can 
then make smaller ones for using on the web or in PowerPoint. 

1.8 Set the Image Settings options: 

 Set all options to OFF or None. 

1.9 Start scanning: 

 Click on the Scan button. 

The scanner will start scanning – depending on the resolution, this may take some 
time. 

1.10 Save your scanned image: 

Your scanned image now appears in the PhotoPlus workspace. Assuming we want 
to keep our scan for future use we will save it as a TIF file. 

TIF (or TIFF) is a universal and ‘lossless’ (i.e. all image information is preserved, as 
opposed to ‘lossy’ compression formats which result in lost data and quality) image 
compression format, suitable for archiving and high quality work. 
However it generates large files and is therefore not suitable for the web and other 
screen display uses. 

 Go to the File menu and choose Export Optimizer. 

 In the Format option, choose Tagged Image File, then in the Pixel Format option, 
choose 24-bit RGB and leave all other options as they are. 

 Click on the Export button and in the Export dialogue box, first navigate to the 
course folder located in your personal UoB filestore (i.e. O:\UoB Training 
Materials\scanning\, then in the File name field type in egypt-mural-original and 
press Save. 
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Task 2 Cropping and correcting perspective problems 

Objectives To crop an image and correct perspective problems. 

Comments Cropping consists of selecting the area of an image that you want to keep and 
eliminating the outer crop area. Using the PhotoPlus Crop Tool and Deform Tool 
you will learn to correct perspective problems such as the vanishing vertical edges 
of a building photographed from ground level. 

 

Simple cropping operation 

2.1 Define the crop area: 

 In the Toolbox, select the Crop Tool1.  

 Click in the top left corner of the area you want to select and drag towards the 
bottom right to mark out the area that you want to keep (crop marquee). Notice how 
the area outside the crop selection dims. 

 Adjust the crop marquee to cover an area similar to that in Figure 3: 

 
Figure 3 – the crop marquee in the image window 

If you need to reposition the crop marquee, place the cursor inside the marquee – it 
will change to a white cross – and drag. 

2.2 Commit the crop: 

 When you are satisfied with the position and size of the crop marquee, double-
click in the crop marquee or click the OK button2 in the context toolbar.  

Crop Tool handles Crop Tool handles Crop Tool handles 

1 

2 
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Correcting perspective problems 

2.3 Correct the perspective:  

 In the Toolbox select the Deform Tool3. 

 Press the <Ctrl> key and with the mouse click the top left corner handle and drag it 
outward to straighten the skewed vertical line on the left in the image (Figure 4). 

 
Figure 4 – Correcting perspective with the Deform Tool 

 Repeat, using the other corner handles to correct the right side vertical line and level 
the bottom and top horizontal lines in the image. 

 Once you are satisfied with your selection, commit the perspective correction 
by selecting the Move Tool4 in the toolbox. 

Your image should now have perfect vertical and horizontal lines, as illustrated in 
Figure 5: 

 
Figure 5 – Cropped image after perspective correction 

3 

4 
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Note     This operation can be fiddly, particularly with images that do not have clear vertical 
and horizontal lines. Trial and error and a little patience should overcome any 
difficulty! 

2.4 Save your cropped image: 

 Go to the File menu and choose Export Optimizer. 

 In the Format option, choose Tagged Image File, then in the Pixel Format option, 
choose 24-bit RGB and leave all other options as they are. 

 Click on the Export button and in the Export dialogue box, first navigate to the 
course folder located on O:\UoB Training Materials\scanning\, then in the File 
name field type in egypt-mural-cropped and press Save. 
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Task 3 Adjusting overall tone and colour 
Objectives To make basic image corrections using PhotoPlus’s image correction tools. 

Comments Once you have cropped your image, the next thing you will want to do is improve its 
appearance. For example it may lack contrast, have a colour cast, be too bright, or 
displays any combination of these faults. 

 

Interpreting an image 

3.1 Before making any adjustment, it is important to be able to analyse the image you 
are working on. 

We can use our eyes to make subjective judgements about how the picture looks, 
but we can also use the image histogram, which is useful for evaluating the kinds of 
image adjustments that may be needed. 

 Look for the Histogram tab among the Studio tabs on the right. 

Note    If you can’t see the Histogram tab see, open the Window menu (in the top menu 
bar) then select Studio Tabs > Histogram Tab. 

 Click the Tab Menu button at the top right of the tab and select Show Statistics. 

 Click it again and select RGB – this option shows the distribution of composite RGB 
values, rather than individual colour channels (e.g. Red Channel) or all three 
separate channels (All Colours). 

 
Figure 6 – Histogram tab with statistical information 

 What does the information provided by the Histogram tell you about the current 
image? 

Adjusting brightness and contrast with Levels 

3.2 Create a Levels adjustment layer:  

 Look for the Layers tab in the bottom palette on the right (it should already be 
active) and click on the New Adjustment Layer icon5 in the bottom taskbar, 
and select Levels. 

This will open the Levels adjustment layer (Figure 7). 

3.3 Resetting the input shadow and highlight levels: 

 Take a minute or so to look at the Figure 7 and read the description. 

Histogram Tab Menu button 
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5 

Statistical 
information 

Tonal range 
255 (white) 
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Figure 7 – Levels adjustment layer dialogue box 

Input Levels 

 The Input sliders and entry boxes allow you to increase the contrast by 
adjusting the input shadows and highlights. 

 The Gamma slider and entry box work on the image midtones and allow you to 
adjust the relative image brightness between the shadows and highlights (drag 
the slider left to lighten and right to darken the image). 

Output Levels 

The Output sliders allow you to reduce the tonal range (contrast) in an image. It is 
best not to touch these because they inevitably result in loss of data in the shadows 
and highlights – unless you deliberately want to reduce the output contrast. 

The histogram in Figure 7 shows that the image has a limited tonal range which 
explains the lack of contrast; in other words it is lacking in shadows and highlights. 
So the first adjustment we are going to make is reset the darkest shadow and 
lightest highlights points for each of the RGB colour channels. 

 Make sure the Preview box in the bottom right is checked so you can see the 
changes taking place. 

 In the dropdown Channel selector, select Red. 

 First drag the Shadows input slider to the right and set it just before you see some 
shadow detail in the image (i.e. where the histogram starts). Then drag the 
Highlights input slider to the left and set it just before you see some highlight 
detail. 

 Repeat the previous step for the Green and Blue channels and click OK once you 
are satisfied. 

Notice how these changes have affected the RGB histogram in the Histogram tab 
(Figure 8): 

Channel selector 

Input highlights 
levels slider 

Gamma 
(midtones) slider Input shadows 

levels slider 

Output highlight 
levels slider 

Output shadow 
levels slider 

Auto adjust 

Restore default 
settings 
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Figure 8 – Image histogram after Levels changes 

You should now have a better spread of pixel levels between shadows and 
highlights, but notice how some information has been lost at some levels (hence the 
comb-like effect). 

Adjusting the colour balance with Levels 

3.4 In the previous task, we used the Levels adjustments on individual channels to 
correct the overall contrast of the image. We are now going to use the same tool to 
correct colour casts. 

 Create a new Levels adjustment layer above the one you created in the previous 
task (just make sure it is selected before creating a new layer). 

At this point you need to decide whether your image has a colour cast and if yes, 
which colour. So let’s say your picture looks bluish: 

 Go to the Channel menu and select the Red channel. 

 Move the Gamma slider slightly to the left as in Figure 9: 

 
Figure 9 – Correcting a blue cast using Levels 

If your image has a different colour cast, use the following table to decide which 
channel to use: 
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Colour cast: Use the colour 
channel: 

Move the 
Gamma slider: 

Colour 
added: 

Red Red Right Cyan 

Green Green Right Magenta 

Blue Blue Right Yellow 

Cyan Red Left Red 

Magenta Green Left Green 

Yellow Blue Left Blue 

 

Note    When dealing with black and white photographs, you don’t need to adjust each 
colour channel separately. To correct the overall contrast and brightness you can 
use the composite RGB channel instead. Use the Input sliders to improve the 
overall contrast, and then the Gamma slider to correct the brightness. 

Alternative colour adjustments with Colour Balance 

3.5 Create a Colour Balance adjustment layer: 

 First disable the second Levels layer (the one you used to adjust colours in the 
previous task) by clicking on the eye next to it. 

 In the Layers tab click on the New Adjustment Layer icon in the bottom taskbar, 
and select Colour Balance (Figure 10). 

 
Figure 10 – Colour Balance dialogue box 

 Make sure Preview is selected and start working on the Midtones and then move 
on to the Shadows and Highlights. Also experiment with the Preserve Lightness 
option in the bottom left. 

 Observe the changes to your image as you do this and click OK once you are 
satisfied with the results. 
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 Now compare the results with the first method by disabling/enabling the second 
Level layer and the Colour Balance Layer. 

3.6 Save your image in the Adobe Photoshop (PSD) format: 

 Go to the File menu and choose Export. 

 In the Export dialogue box, navigate to O:\UoB Training Materials\scanning\ if 
necessary. In the File name field type egypt-mural-cropped-adjustments and in 
the Save as type field select PhotoShop (*.psd). Press Save. 

Note    We recommend that you use the Adobe Photoshop format (.PSD) in preference of 
the native PhotoPlus Pictures format (.SPP) because it is more widely used and it 
will then enable you to open your working files in Photoshop CS or Element (as well 
as many other image editing applications) if you want to. 

However if you are not bothered about this you can save your working files in the 
PhotoPlus native format by going to Files / Save as and selecting PhotoPlus 
Pictures (*.Spp) as the file type. 

Both .PSD or .SPP will preserves all image information, such as multiple layers, 
masks, etc which otherwise would be lost. This means you can carry on working on 
the image at a later time. 
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Task 4 Sharpening an image 

Objectives To sharpen an image. 

Comments Most digital photographs – and particularly those resulting from scanning – need 
some degree of sharpening to bring out detail. PhotoPlus provides four sharpening 
filters – Sharpen, Sharpen More, Sharpen Edges and Unsharp Mask. Unsharp 
Mask is the one that gives the most control. 
See http://www.cambridgeincolour.com/tutorials/unsharp-mask.htm and 
http://www.cambridgeincolour.com/techniques/image-sharpening.htm for more 
detailed information on sharpening. 

 

The Unsharp Mask works by increasing the contrast between pixels next to one 
another. Unlike tone and colour adjustments, Unsharp Mask is applied to the 
Background layer (or even better a copy of the Background layer), that is the layer 
containing the original image. 

Creating a Background copy 

4.1 Create a copy of the Background layer: 

Note    Creating a copy of your background image protects the original image because it is 
easier to delete a layer rather than undo changes to the background image. 

 In the Layers palette, select the Background layer and right-click on it. Then select 
Duplicate (this option can also be found in the Layers menu at the top). 

 In the Duplicate Layer dialogue box accept the suggested name (Background 
Copy) and press OK (Figure 11). 

 
Figure 11 - Dublicate Layer dialogue box 

Applying the Unsharp Mask 

4.2 Sharpen the image: 

 Make sure the Background Copy layer is selected and in the Effects menu, 
choose Sharpen / Unsharp Mask. 

 In the Unsharp Mask dialogue box (Figure 12) you can set three settings: 

 Amount controls the amount of sharpening applied to the edges (1% to 500%). 
Values up to 50% produce subtle effects; values between 50% and 250% 
produce moderate effects. A good starting point is often a value of 100%. 

 Radius controls the size of the edges you wish to enhance, where a smaller 
radius enhances smaller-scale detail. Values of up to 2.0 produce acceptable 
sharpening. 

http://www.cambridgeincolour.com/tutorials/unsharp-mask.htm
http://www.cambridgeincolour.com/techniques/image-sharpening.htm
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 Threshold controls the amount of contrast between pixels an area must have 
before it will be modified. Use a low value to apply the filter more generally 
throughout the image. For example it allows you to sharpen more defined edges 
while leaving more subtle edges unaffected. 

 
Figure 12 – Unsharp Mask settings in the Filter Gallery 

Note    A good method is first to set the Amount to 100% and the Threshold to 0. Then 
experiment with the Radius and finally adjust the Amount if necessary before 
finishing with the Threshold if needed. You may require a few iterations before 
finding a satisfying result. 

 Experiment with the different settings described above and observe the changes to 
the image. 

As a general rule, apply an amount of between 200% and 300%, a radius of 
between 0.5 and 2.0, and a threshold of between 0 and 10. 

Note    Sharpening for output should be applied at the end of the process and after the 
image has been resized to the final print size. 

4.3 Save your image: 

 Go to File / Export and replace the egypt-mural-cropped-adjustments with the 
new one (make sure it is saved in the PhotoShop (*.psd) format). 

Merging layers 

4.4 Make a copy of the image: 

 Open the Image menu at the top and select Duplicate. Accept the suggested name 
egypt-mural-cropped-adjustmentsCopy. 

 Close egypt-mural-cropped-adjustments.Spp. 
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4.5 Merge the visible layers: 

 Make sure either the Colour Balance layer or the second Levels layer is disabled 
by clicking on the eye icon next to it (remember that we used both methods to 
achieve the same effect, so keep the one that gave the best results). 

 Open the Layers menu at the top and select Merge / Merge Visible. Then delete 
the remaining hidden layer. 

4.6 Save this image as a TIFF: 

 Go to the File menu and choose Export Optimizer. 

 In the Format option, choose Tagged Image File, then in the Pixel Format option, 
choose 24-bit RGB and leave all other options as they are. 

 Click on the Export button and in the Export dialogue box, first navigate to the 
course folder located on O:\UoB Training Materials\scanning\, then in the File 
name field type in egypt-mural-cropped-adjustments and press Save. 
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Task 5 Resampling an image 

Objectives To resize and/or resample an image. 

Comments There are times when you will want to modify the size of an image (for example to 
create a version of your image for the web). This is done through a process called 
interpolation (also known as resampling). Image interpolation consists in 
estimating the value (colour and intensity) of new pixels based on the values of 
existing surrounding pixels. 
See http://www.cambridgeincolour.com/tutorials/image-resize-for-web.htm for 
downsizing an image and http://www.cambridgeincolour.com/tutorials/digital-photo-
enlargement.htm for digitally enlarging an image. 

 

Resampling down 

Resampling down consists in discarding pixels and results in a smaller file size. Use 
this method when downsizing images for the Web and email. 

5.1 Prepare to resample the image: 

 Go to the Image menu at the top and select Image Size to open the Image Size 
dialogue box (Figure 13). 

 
Figure 13 – Image Size dialogue box 

 Check that Maintain aspect ratio is also selected. 

5.2 Resize the image: 

 Under the Pixel Size options, set the Width to 300 pixels. The Height will 
automatically be adjusted to preserve the aspect ratio. 

 Under Resampling Method, slide the cursor completely to the right, until you see 
Lanczos3 Window, and press OK. 

http://www.cambridgeincolour.com/tutorials/image-resize-for-web.htm
http://www.cambridgeincolour.com/tutorials/digital-photo-enlargement.htm
http://www.cambridgeincolour.com/tutorials/digital-photo-enlargement.htm
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Note    As a general rule, when resampling photographs, use Lanczos3 Window for best 
quality. Bicubic interpolation is the next best method, followed by Bilinear 
interpolation and Nearest pixel being the most basic. 

5.3 Apply some sharpening: 

After downsizing your image you may want to apply a small amount of sharpening. 

 Create a copy of the background layer as in task 4.1. 

 Use the Unsharp Mask as explained in task 4.2, setting the Amount to about 120 
and the Radius between 0.2 and 0.5. Leave the Threshold to 0. 

5.4 Save the thumbnail image as a JPEG: 

 Go to File / Export Optimizer. 

 In the Export Optimizer dialogue box (Figure 14), select JPEG as the Format and 
leave the Lossless and Mate options unchecked. 

 
Figure 14 - Export Optimizer settings 

 Change the preview option from single pane to four panes by pressing the 
Quad view icon8. 

Now use the 4 preview panes to compare different compression levels: 

 Select the top left pane and change the Quality option to 100%, then select the top 
right pane and set the Quality to 80%. Repeat with the bottom left and bottom right 
pane, setting the Quality to 60% and 40%. 

 Compare the different panes by zooming in (look for the zoom in icon9 )and 
focusing on a detail of the image. Notice the deterioration in the image and also 
the reduction in file size as the quality decreases. 

8 

8 
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Notice in particular how a 20% reduction in quality (from 100% to 80%) results in an 
over 500% reduction in file size (from 126Kb down to 23.5Kb)! 

Note    In most cases 80% quality will achieve the best compromise between quality and file 
size for web display. 

 Finally, select the 80% quality pane (you will see a blue frame around the selected 
pane) and press Export. In the Export dialogue box, first navigate to the course 
folder located on O:\UoB Training Materials\scanning\, then in the File name field 
type in egypt-mural-thumb and press Save. 

Setting the print size of an image 

You can also use the Image Size dialogue box to set the print size of an image 
using different resolutions without resampling it. 

 Reopen Egypt-mural-cropped-adjustments.tif and go to Image / Image Size. 

 In the Image Size dialogue box, uncheck the Resize layers option and notice how 
the Pixel Size and Resampling method options are now uneditable (Figure 15): 

 
Figure 15 - Image Size dialogue box with the resampling options off 

 In the Print Size options, change the Resolution (for example try 200 and 300 
pixels/inch) to see the changes to the Width and Height dimensions (the default 
unit is inches, but you can change it to centimetres if you prefer). 

 Choose a resolution other than 100 and press OK. 

 Go to File / Print and in the Print Studio dialogue box, open the Layout option on 
the left, and in the Size drop down select Image Print Size. 
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Appendix A Image file formats 
For most digital imaging purposes, and in the context of this practical workbook, you need to be 
aware of four image file formats: TIFF, JPG, SPP and GIF 

 TIFF: The most common cross-platform format for images. TIFF is the format of choice for 
scanned images and archival purposes because it keeps all image data intact. On the 
minus side, TIFF generate large files and is not suitable for the Web. 

 PSD: This is the Adobe Photoshop’s format, and although it is proprietary to Adobe, it has 
become something of a standard and is widely supported by other image editing 
applications (including Serif PhotoPlus). It can be used as an alternative to TIFF for 
archiving purposes. The main advantage of saving in this format is that it preserves all 
working layers, which can be useful for future editing. 

 JPEG: This is one of two standard compression formats used for preparing images for the 
Web (the other one being GIF). It offers a smaller file size than TIFF and is the format of 
choice to compress photographic images for the Web. Another big advantage is that it 
allows for different levels of compression which can be balanced against file size. 

 GIF: This is the other image file format used for preparing images for the Web. It is an 8-bit 
(i.e. 256) colour display mode that indexes specific colours to each of the 256 (or fewer) 
numeric values. This makes it unsuitable for photographic (i.e. continuous tone) images 
that potentially contain millions of colours. Therefore it works best with simple images 
containing block colours, such as logos, graphics, etc. Finally GIF support transparency, 
which can be useful on the Web. 

Other image file formats you should be aware of include: 

 SPP: This Serif PhotoPlus’s proprietary format, which is unlikely to be supported by other 
applications. Therefore we suggest that you use Photoshop’s PSD format instead. 

 PNG: The Portable Network Graphics format is an open standard that combines the 
benefits of JPEG and GIF. As such it is very flexible and perfectly suitable for the Web. 
However it is not as widely used as either. 

 BMP: Also known as bitmap, is a high quality format similar in purpose to TIFF. However it 
is proprietary to Microsoft and for this reason the open standard TIFF should be preferred 
instead. 

 

Further reading: 

 JISC Digital Media – Choosing a File Format for Digital Still Images 
(http://www.jiscdigitalmedia.ac.uk/stillimages/advice/choosing-a-file-format-for-digital-still-
images/) 

 Cambridge in colour – Image types: JPEG and TIFF files 
(http://www.cambridgeincolour.com/tutorials/imagetypes.htm) 

 Scantips - Image File Formats - TIF, JPG, PNG, GIF Which to use? 
(http://www.scantips.com/basics09.html)  

 

 

http://www.jiscdigitalmedia.ac.uk/stillimages/advice/choosing-a-file-format-for-digital-still-images/
http://www.jiscdigitalmedia.ac.uk/stillimages/advice/choosing-a-file-format-for-digital-still-images/
http://www.cambridgeincolour.com/tutorials/imagetypes.htm
http://www.scantips.com/basics09.html
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Appendix B Resolution and image size for printing 
    Print size at: 

Pixel size Megapixels RGB size 
(MB) 

CMYK size 
(MB) 

150 ppi 300 ppi 

1600 x 1200 2 6 7.5 11 x 8 inch 
(28 x 20 cm) 

5.5 x 4 inch 
(14 x 10 cm) 

2400 x 1800 4.3 12.5 16.5 16 x 12 inch 
(40 x 30 cm) 

8 x 6 inch 
(20 x 15 cm) 

3000 x 2000 6 17.5 23.5 20 x 13 inch 
(51 x 33 cm) 

10 x 6.5 inch 
(25 x 16.5 cm) 

3500 x 2500 8.75 25 33.5 23 x 17 inch 
(58.5 x 43 cm) 

11.5 x 8.5 inch 
(29 x 21.5 cm) 

Table 1 – comparison of pixel resolution, megapixels, megabyte file size and print output 
dimensions at different resolutions in inches (and centimetres) 

 

Output use Screen ruling x 1.5 Standard quality 
output resolution 

x 2 High quality 
output resolution 

Newspaper 65 – 100 lpi 97 – 150 ppi 130 – 200 ppi 

Books 120 – 150 lpi 160 – 225 ppi 240 – 300 ppi 

Colour magazine 150 – 175 lpi 225 – 262 ppi 300 – 350 ppi 

Art book/magazine 175 – 250 lpi 262 – 375 ppi 300 – 500 ppi 

Photo quality inkjet printer 150 – 300 lpi 225 – 450 ppi 300 – 600 ppi 

Table 2 – rule of thumb screen resolutions for common print devices at lpi x 1.5 and x 2 
quality factors 

 

Example 

Say you want to print a high quality A4 photograph on an inkjet printer: 

A4 size = Width 8.268 x Length 11.693 inches (21 x 29.7 cm) 

Printer resolution = 200 lpi 

Quality factor = x 1.5 

Print length x Printer resolution x Quality factor = number of pixels required in length 

11.693 x 200 x 1.5  3500 pixels in length 

Print width x printer resolution x Quality factor = number of pixels required in width 

8.268 x 200 x 1.5  2480 pixels in width 
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Appendix C Further resources 
 

A collection of links to useful digital imaging resources is available at: 

http://delicious.com/uobittraining/scanning 

It is kept up to date and added to as new resources are found. 

http://delicious.com/uobittraining/scanning

